
Handy Tips, Solutions and Answers to
Common PC Questions
Do you have a question about a Windows Advisor article, or
need help with a computing problem? If you do, just drop
us a line by email to editorial@windowsadvisor.co.uk and
we’ll do our level best to help!

When you write, please remember to include your customer
number, your postcode, and the version of Windows you use
(Windows 10, Windows 8.1, Windows 7). Give us as much
detail as you can about the problem to help us understand
what’s happening, and feel free to attach a screenshot or
document if you think it would help to illustrate the problem
or error.
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Excel: Change a Cell’s Colour According 
to its Content
Question: A colleague has sent me a Microsoft Excel spread-
sheet which does something I find amazing: if a formula
results in a figure of over 100, the cell’s background turns
red. How is that done?

Jim Lofthouse

Answer: This rather-impressive feat is handled by an Excel
feature named Conditional Formatting. As its name suggests,
when you specify a particular ‘condition’ for a cell, such as
its figure being greater than 100 or less than zero, Excel
watches out for that condition and applies whatever
formatting you’ve chosen – turning the cell’s background
red in this case.

This trick is commonly used to ensure your attention is
drawn to something important. After adding or changing
some figures in the spreadsheet, you might not notice that
the cell now contains a figure of over 100, but you would
quite likely see that it’s suddenly turned red.

Changing the cell’s colour is just one example of the
formatting you could use to highlight a particular condition
(you might make the cell’s text bold, or bright blue, for
instance). However, let’s take the example that you want to
turn a cell’s background to red whenever the formula it
contains produces a figure over 100. Here’s what to do:

Automatic
formatting?

Use Conditional
Formatting

Easily spot
important
figures

Format figures
in many
different ways

1.  Select the cell whose formatting
should change according to the
figure it contains.

2.  Select the Home tab on the Ribbon
and, in the ‘Styles’ section, click
the Conditional Formatting button.

:
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Set the ‘greater
than’ figure

Choose a 
font style…

3.  Move the mouse to Highlight Cells Rules and click
on Greater Than.

4.  In the dialog that appears, below the text Format
cells that are GREATER THAN, type the figure 100.

5.  Open the drop-down list beside the word with and
choose Custom Format.

6.  In the Format Cells dialog that appears, you’ll be
initially looking at the Font tab. Here you can choose
what font should be used to display the cell’s value
when its exceeds 100: you might choose to make the
font bold and white, for example, to make it stand
out better against the red cell background we’ll
specify in a moment.
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The new conditional formatting takes effect imm-ediately
for the cell you selected. If you change figures in the
spreadsheet that result in that cell’s value being over 100, it
will be filled with a red background; if the value is 100 or
less, the cell will be displayed with its normal formatting.

…and select 
a colour for 
the cell

Done!

Excel monitors
that cell’s figure

7.  Switch to the Fill tab , and here you can choose
what colour the cell’s background should be when
its value exceeds 100. Click on a red square to
select that colour. Finally, close the Format Cells
dialog by clicking OK . 

1

2

3

8.  This takes you back to the little Greater Than
window; click OK. 

1

2

3
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If you want to change the conditional formatting you’ve set,
select the cell again, click the Conditional Formatting
button on the Home tab again and choose Manage Rules:
here you can select the rule you’ve just created and choose
Edit Rule to make changes to it.

If you want to remove the conditional formatting from the
cell, select the cell and then choose Conditional Formatting
> Clear Rules > Clear Rules from Selected Cells.

Along with the ‘Greater Than’ condition we’ve used in this
example, Excel offers various others such as ‘Less Than’,
‘Between’ and ‘Equal To’, so you can set up similar ‘warnings’
for a variety of different conditions in a similar way.

Open the CD/DVD Drive Without Using
the Button  
Question: The button for opening the CD/DVD drive on my
notebook PC is stuck. The only way I can get the drive try
tray open is with a lot of rattling and prodding. Will I have
to replace the drive or is there another way?

Frank Scott
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Edit the
conditional
formatting…

…or remove it

Other conditions
can be used

Eject button
broken or
awkward?
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There’s another
way to open the
drive tray

Right-click the
drive’s icon and
choose Eject

Answer: On notebook computers in particular, the CD/DVD
drive trays and their components are notoriously flimsy, so
it’s not unusual for the eject button to give up the ghost.
But, on any computer, you might find that the drive’s eject
button stops working, gets stuck, or just isn’t easy to reach.

If you can’t use the drive’s eject button, there’s another trick
you can use to open the drive tray:

1. Start File Explorer (aka Windows Explorer in Windows
7) by pressing the key combination + .

2. In the left-hand panel of the File Explorer window,
click on This PC in Windows 10 or 8.1, or
Computer in Windows 7.

3. The right-hand side of the window will now show
icons for all the drives connected to your PC,
including your CD/DVD drive .

4. Right-click the icon for your CD/DVD drive, and
then click Eject on the context menu that opens.

1

2

3

E
:
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Word: Which Part of this Document Was 
I Editing? 
Question: I’ve heard that in Word 2016 there’s a feature
that can take me straight back to the part of a document I
was last working on as soon as I open the document. Where
do I find this, and how does it work? Also, is there anything
similar in older versions of Word? At the moment I make a
note in the text to remind me where I was.

Raymond Bridges
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Find the part of
the document
you were last
working on

5. The drive tray will open, and you can insert a disc
(or remove the disc you were using) and then close
the tray by pushing it gently back into place.

1

2

3
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Answer: Whenever you open a document in Word 2016 (or
any other version of Word for that matter), you’ll always be
looking at the top of the document, with the text cursor
flashing at the very beginning.

However, in Word 2016 and 2013, you’ll see a little notice
at the right of the window that says ‘Welcome back!’; this
notice shows which part of
the document you were
working on when you last
closed the docum-ent (or
closed Word itself). If you
click this notice with the left
mouse button, Word will
take you straight to that part of the document so that you
can carry on from where you left off.

If you don’t click this notice within a few
seconds, it reduces in size to show just a small
flag, but you can still click it with the same
result as clicking the larger notice.

If you click somewhere else in the document and/or start
typing, the notice or flag will disappear.

It’s a neat little feature, particularly if you regularly work
on lengthy documents. But what if you’re not using Word
2016 or 2013?

In that case, there’s another trick you can use. This works
in all recent versions of Word: you can even use it in Word
2016 and 2013 if that little ‘Welcome back!’ notice has
disappeared.

After opening a document, press the key combination 
+ . The text cursor then jumps to the point in the

document where you last made a change. Microsoft Word
Shift F5
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The cursor starts
at the top of the
document

The ‘Welcome
back!’ feature in
Word 2016 
and 2013

Click the 
notice or the
smaller flag

Use this trick in
other versions

Jump between
the last four
editing positions
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remembers the last four positions in your document where
changes were made, so by pressing + repeatedly
you can jump quickly between all these locations. When
you’ve reached the fourth location and you press +

again, you’ll jump back to the first.

Shift F5

Shift
F5

Is My New External Hard Drive a Rip-off? 
Question: I’ve just bought an external hard drive to gain
some extra storage space for my files. It was sold as a 500
GB drive, but after connecting it to my PC Windows tells me
the drive has 465 GB available. Have I been short-changed?

Jamie Glover

Answer: Technically the answer is no, you haven’t been
ripped off, but when I explain the reason why your new
drive seems to offer less space than it should, you might feel
that the drive’s manufacturer was being less than honest
with you! However, it would be unfair to single out that one
manufacturer – the whole industry behaves this way.

It comes down to different ways of counting and measuring
things. We humans like to use the decimal system – base 10
– in which things are counted in tens, hundreds and
thousands. Computers use the binary system – base 2 – in
which things are counted in twos, fours, eights, sixteens,
and so on.

The Windows Advisor   November 2018 15

09Questions & Answers

Less space than
you were led to
believe?

A sneaky
practice of drive
manufacturers

Decimal vs.
binary systems

Of course, this trick isn’t only useful when you’ve just
opened a document. If you’re working on a long
document and you scroll up a few pages to make a
change, a quick press of + afterwards will
take you straight back to the point you’d been working
on just beforehand.

Shift F5
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The usual way
computers
measure sizes

Drive capacities
are given using
the decimal
system

The picture
always breaks 
up the text

To a computer, then, a kilobyte isn’t a thousand bytes, it’s
1024 bytes. A megabyte is 1024 kilobytes, and a gigabyte is
1024 megabytes. So, when you buy a 500 GB drive, you
might reasonably expect to be getting 500 of those
gigabytes – 512,000 megabytes.

In fact, though, manufacturers of disk drives sneakily switch
to using the decimal system to state the capacities of drives,
so every advertised ‘gigabyte’ is actually 1000 megabytes,
not 1024 megabytes. It may seem a small difference, but
those lost 24s add up, and when you look at the drive’s
capacity in Windows (which does measure things the correct
computer way), you’ll see they’ve added up to a loss of 35
gigabytes: your ‘500 GB’ drive is really a 465 GB drive.

Incidentally, there’s another thing that can cause an
apparently-empty drive to offer less space than it
should. When you format a disk, which prepares it for
use in a PC, the formatting process has to create a
kind of ‘table on contents’ on the disk which enables
Windows to find the files stored on the disk. This
table of contents varies in size according to the type
and size of the disk, but even on an apparently-empty
disk the table of contents will occupy a small
percentage of the space and will result in your having
still less available space than the advertised capacity.

Word: Place a Picture Freely on the Page 
Question: How can I move a picture to the side of the page in
a Microsoft Word document? If I try to drag it to where I want
it, I can make it jump from place to place on the page, but never
without breaking up the text or leaving large white spaces.

Margaret Goff
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If the text cursor is somewhere within a paragraph of text
when you insert the picture, the text will be split at the
cursor position and the picture will be inserted there, as in
the screenshot above, just as if you’d inserted a word or
sentence there, and the height of that line grows to match
the height of the picture.

If you try to drag the picture elsewhere, Word will keep it
‘in line with the text’, behaving as if you were dragging a
word, sentence or paragraph around the page.

To be able to move the picture freely to wherever you want
it, you have to change that ‘In Line with Text’ setting to
something different after inserting the picture. Here’s how
that’s done:
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Picture appears
at the cursor
position

Change the text
wrapping option

1. Double-click the picture , which does two jobs
in one: it selects the picture in preparation for
adjusting its options, and it switches to the Picture
Tools > Format tab on the Ribbon .

1

2

:

Answer: When you insert a picture into a Word document,
Word applies a setting to the picture named ‘In Line with
Text’. This makes the picture behave like a piece of text itself
– a word or a sentence.
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Set text
wrapping to
‘Square’

Text flows
around the
picture

2. In the ‘Arrange’ group of the Ribbon, click the Wrap
Text button .

3. On the menu that appears,
choose Square .

4. Using the left mouse button,
you can now click-and-drag
the picture to wher-ever you
want it, such as to the side of
the page.

3

4

As you’ve set the text-wrapping option to ‘Square’, the text
in your document will now wrap around the square edges
of the picture, as shown in the screenshot above.

1

4

2
3
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Lock Your PC to Hide Your Work and Keep
Tiny Fingers Out! 
Question: I’ve learned from bitter experience to shut down my
PC if I have to leave it for a few minutes when my grand-
children are around. Although there’s no danger of fiddling
then, the process of closing everything and shutting down,
then waiting for it to start again and reopening everything,
isn’t a quick one! Can you suggest a better alternative?

Gordon McKee

Answer: Yes, a much better one! Whenever you have to
leave your PC for a short time, and you’re worried that
someone else could see what you were working on or
tamper with the computer, just follow these steps: 
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Leaving your PC
running and
unguarded?

Windows can
hide your work
while you’re
away

The Lock screen
covers your
windows

You can even move the picture into the margins of the
document, but be careful not the place it too close to
the edge of the page if you plan to print the document:
most printers can’t print to the very edges of the paper.

1. First, to be absolutely safe, make sure you’ve saved
any documents you were working on. There’s no
need to close your programs or minimise them,
though – you can leave everything exactly as it is.

2. Now press the key combination + (the
Windows-flag key and the ‘L’ for ‘lock’ key).

3. Immediately, Windows returns you to the ‘Lock
screen’ you see shortly after you switch on your PC
(or, in Windows 7, the ‘log-in screen’ which shows
your name and user-picture). It may seem as though
everything you were working on has vanished, and 

L

:
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How Can I Reopen a Browser Tab? 
Question: If I close a tab in my web browser by accident, is
there an easy way to get it back again?

Colin Gill

Answer: Indeed there is – in fact there are several ways.
One is to open the history list (by pressing + ) and
locate the lost web page, then click it in Google Chrome or
hold and click it in Microsoft Edge, Mozilla Firefox
or Internet Explorer.

However, if you’ve only just closed the tab and realised your
mistake, here’s a better way. Right-click one of the
remaining tabs and do the following:

•     Internet Explorer or Google Chrome:
click on Reopen closed tab.

•     Microsoft Edge: click on Re-open closed tab.
•     Mozilla Firefox: click on Undo Close Tab.
The last tab you closed (and its web page) will reappear. If
you prefer to use the keyboard, pressing + +
does the same thing in all four browsers.

Ctrl H

Ctrl

Ctrl TShift

The Windows Advisor   November 201820

Questions & Answers14

Your password 
is needed to 
gain entry

Sign in again
when you’re
ready

Accidentally closed
a web page?

Reopen it from
the history list…

…or quickly
recover the 
last-closed tab

A quick 
keyboard
alternative

    in a way it has, but only because this Lock screen
(or log-in screen) is covering it up. If you could see
behind that screen, you’d find that everything is still
exactly as you left it.

4. Your PC is now ‘locked’: the only way past this
screen is to type your Windows password, meaning
that you can leave your PC and no-one will be able
to see what you were doing or interfere with it.

5. When you’re ready to get back to work, tap the
spacebar to move past the Lock screen in Windows
10 or 8.1, then type your password and you’ll be
straight back to business.
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